ARI Contractor Report 96-57

Instructional Program: Embedded Instructional Program ECI Deliverable

Timothy C. Clifton

BDM Federal, Inc.

August 1996

United States Army Research Institute for the Behavioral and Social Sciences

Approved for public release; distribution is unlimited
NOTICES

DISTRIBUTION: This report has been cleared for release to the Defense Technical Information Center (DTIC) to comply with regulatory requirements. It has been given no primary distribution other than to DTIC and will be available only through DTIC or the National Technical Information Service (NTIS).

FINAL DISPOSITION: This report may be destroyed when it is no longer needed. Please do not return it to the U.S. Army Research Institute for the Behavioral and Social Sciences.

NOTE: The views, opinions and findings in this report are those of the author(s) and should not be construed as an official Department of the Army position, policy, or decision, unless so designated by other authorized documents.
Instructional Program: Embedded Instructional Program ECI Deliverable

Author(s): Timothy C. Clifton

Performing Organization Name(s) and Address(es):
BDM Federal Inc.
DOD CENTER MONTEREY BAY
400 GILGILING ROAD
SEASIDE, CA 93955

Sponsoring/Monitoring Agency Name(s) and Address(es):
U.S. Army Research Institute for the Behavioral and Social Sciences
5001 Eisenhower Avenue
Alexandria, VA 22333-5600

Supplementary Notes:
The COR is Michael R. McCluskey. This report is published to meet legal and contractual requirements and may not meet AR's scientific or professional standards for publication.

Abstract (Maximum 200 words):
The Embedded Instructional Program was developed based on a task analysis to identify the skills required to operate the ECI. The Embedded Instructional Program consists of two components. The first, FORMPLAYER Tutorial, trains the user on how to enter information into a predefined electronic form. The FORMPLAYER Tutorial is divided into nine topics. The second component, FORMDESIGNER Tutorial, trains the user on how to develop electronic forms. The FORMDESIGNER Tutorial is divided into twelve topics.

New ECI users, or user not experienced with computers, should begin with the FORMPLAYER Tutorial. Both FORMPLAYER and FORMDESIGNER Tutorials are imbedded in the ECI program through the ECI Installation Diskettes. Both tutorials provide a self-paced instructional program in which the user will be required to execute the learning topics.

Subject Terms:
FORMDESIGNER, FORMPLAYER, Embedded Instructional Program (ECI)

Security Classification of Report: UNCLASSIFIED
Security Classification of This Page: UNCLASSIFIED
Security Classification of Abstract: UNCLASSIFIED

Number of Pages: UNLIMITED
Price Code: UNLIMITED
INSTRUCTIONAL PROGRAM:
EMBEDDED INSTRUCTIONAL PROGRAM ECI
DELIVERABLE

Timothy C. Clifton, Ph.D.
BDM Federal

Submitted by: Mr. Michael R. McCluskey, Acting Chief
Unit-Collective Training Research Unit
and Jack Hiller, Director
Training Research Laboratory

Mr. Michael R. McCluskey, Contracting Officer's Representative

January 27, 1995
U.S. Army Research Institute
INSTRUCTIONAL PROGRAM

The Embedded Instructional Program, outlined in Task 8 of the SOW and listed as Deliverable Line Item 0007-07-0007, is provided as attached. The program was developed based on a task analysis to identify the skills required to operate the ECI.

The Embedded Instructional Program consists of two components. The first, FORMPLAYER Tutorial, trains the user on how to enter information into a predefined electronic form. The FORMPLAYER Tutorial is divided into nine topics, as follows:

1. How to switch to FORMPLAYER using the Alt + Tab keys.
2. How to use Help.
3. How to enter information and move to different text fields.
4. How to move to the next page in a form.
5. How to enter information into Date/Time fields.
6. How to enter information into Noneditable fields.
7. How to move to different records in a database and how to create new records.
8. How to save your work and exit the FORMPLAYER program.
9. Summary of what you should know about FORMPLAYER.

The second component, FORMDESIGNER Tutorial, trains the user on how to develop electronic forms. The FORMDESIGNER Tutorial is divided into twelve topics, as follows:

1. How to switch to FORMDESIGNER using the Alt + Tab keys.
2. How to retrieve a blank ECI form.
3. How to use Help.
4. Orientation to the FORMDESIGNER screen.
5. Creating labels.
6. Creating alpha and numeric fields.
7. Creating textboxes.


9. Creating labels and Date/Time fields.

10. Creating checkboxes and listboxes.

11. How to switch to FORMPLAYER mode.

12. **Summary** of what you should know about FORMDESIGNER.

New ECI users, or user not experienced with computers, should begin with the FORMPLAYER Tutorial. By using the FORMDESIGNER Tutorial, the user will become familiar with the characteristics and design of forms contained in FORMPLAYER. Once users understands FORMPLAYER, they can continue the learning process with the FORMDESIGNER Tutorial.

Both FORMPLAYER and FORMDESIGNER Tutorials are imbedded in the ECI program through the ECI Installation Diskettes. Both tutorials provide a self-paced instructional program in which the user will be required to execute the learning topics.
FormDesigner Tutorial

Welcome to the FormDesigner Tutorial
This tutorial will give you hands on experience with FormDesigner. With a little practice it's easy to use FormDesigner!!

FormDesigner allows you to create electronic forms which can be used to enter data. FormDesigner makes it easy to create and modify forms.

How the tutorial works
A tutorial isn't something that you just read!!! A good tutorial gives you hands on experience with the software that you are learning. Therefore, you will be switching back and forth between the tutorial and the FormDesigner software. You will learn by doing.

The structure for this tutorial will show you a concept about FormDesigner and describe it using text and pictures. Then, you will switch to FormDesigner so that you can get hands on experience.

How long will this tutorial take?
You should allow at least two hours to complete this tutorial. The great thing about this tutorial is that it is self paced so you can take as much time as you need to learn the material. You may decide to learn all the material in one session or have several smaller tutorial sessions. It's up to you!!

IMPORTANT NOTE
Before proceeding, it is important to remember that all the commands for this tutorial will refer to the mouse pointer and key strokes. The tutorial and FormDesigner assume knowledge of basic windows commands. Any references to menu commands or clicking on objects refers to using the mouse pointer:

Whenever the program is processing the hourglass icon will appear:

Pen users wanting to learn how to use pen commands should consult Windows Pen Help because this material will not be covered in this tutorial.

To continue, click HERE.
FormDesigner Tutorial

Background
FormDesigner allows you to make electronic forms. In other words, use FormDesigner when you need to make a form to collect information.

There is a companion software program called FormPlayer and its purpose is to run the electronic forms created by FormDesigner.

It is important to understand the distinction between these two software programs. FormPlayer is used to enter data into forms. FormDesigner is used to make forms.

It is recommended that if you do not have experience with either software package to start with FormPlayer. To begin the FormPlayer tutorial, click the Done button at the top of the screen. Next, double click on the FormPlayer tutorial icon.

To continue the FormDesigner tutorial, click HERE.
FormDesigner Tutorial

Overview of Topics
This page covers the major topics for the FormDesigner tutorial. You can switch directly to these topics by clicking on them. If this is the first time you have done the tutorial, start with topic 1.

Part I. Getting Started
Topic 1. How to switch to FormDesigner using the Alt + Tab keys.

Topic 2. How to retrieve a blank ECI form.

Topic 3. How to use Help.

Part II. How to Make a Form
Topic 4. Orientation to the FormDesigner screen.

Topic 5. Creating labels.

Topic 6. Creating alpha and numeric fields.

Topic 7. Creating textboxes.


Topic 9. Creating labels and date/time fields.


Topic 11. How to switch to FormPlayer mode.

Part III. Summing up
Topic 12. Summary of what you should know about FormDesigner.

These 12 topics provide you with the basics for understanding and using FormDesigner.
FormDesigner Tutorial

First things first
First, you need to learn how to switch back and forth between the tutorial and FormDesigner. This is important because it will allow you to try out things discussed in the tutorial. You can do this by holding down the Alt key and then pressing the Tab key. A window will appear as shown below displaying the Program Manager icon:

![Program Manager](image)

Pressing the Tab key again while holding down the Alt key will display any other active sessions that you have in the same window format as above. For example, pressing the Tab key again (while holding the Alt key) will display the following window:

![FormDesigner Tutorial](image)

This window is for the FormDesigner tutorial which you are now running. If you release the keys you are holding down you will be placed in the session window that is currently displayed on the screen.

![Hands on Experience](image)

**Hands on Experience** *(Note: read through these steps first before proceeding!!!!)*

STEP 1. Hold down the Tab and Alt keys at the same time. You should see the following window displayed:

![Program Manager](image)

STEP 2. Release the keys. You should now be in program manager which should look like this:
STEP 3. Hold down the Alt and Tab key again. The following window should appear:

FormDesigner Tutorial

STEP 4. Releasing the keys will bring you back to this tutorial screen.

Learning Points
- Use Alt + Tab keys to display active sessions.
- While holding down the Alt key, continue pressing the Tab key to display other sessions.
- When you get to the session you want, release both keys.

Where do I go from here?
To proceed to the next section where you will learn more about Alt + Tab, click HERE.

To go back and review the previous Alt + Tab screen, click the Back button located at the top of the screen.
FormDesigner Tutorial

Starting FormDesigner
Since it is critical to switch to FormDesigner for this tutorial to be effective, we need to learn how to switch to Program Manager, start FormDesigner, and return back to the tutorial. You have already learned the first part about how to switch. Now, all you need to know is how to start FormDesigner.

When you switch to Program Manager using the Alt and Tab keys the screen should look like this:

You are now located at the Electronic Collection Instrument (ECI) work group containing icons representing different programs. To start FormDesigner, double click on the ECI icon.

You will likely get the warning below. Whenever a form is modified, any data collected with that form previously will be deleted. Databases can be backed up before a form is modified.
We are not concerned about losing data so click Yes. The screen shown below will appear:

Text Objects in ECI

Your Name: [Alpha Field]

Years of Schooling: [Numeric Field]

Please record any comments below regarding logistical or other conditions which adversely affected performance.

Notice how the form's appearance differs from that of FormPlayer. First, fields that are highlighted are outlined with a border: ___. Second, field types are identified (such as "Alpha Field", "Numeric Field"). Third, there are a number of icons at the top of the screen that do not appear in FormPlayer. Some of these icons allow you to choose certain types of fields, others allow you to save the work you have done or switch to FormPlayer to see how the form looks in user mode.

You have started the FormDesigner software. More importantly, you have two programs running at the same time: the tutorial and FormDesigner. If you hold down the Alt and Tab keys the tutorial window will appear:

FormDesigner Tutorial

Releasing the keys at this point will place you back into the tutorial on this screen. Pressing the Alt and Tab key again will make the following window appear:
This window represents the FormDesigner software. Releasing the keys will place you in the FormDesigner software. You can now directly switch between the tutorial and FormDesigner using the Alt and Tab keys. This is useful because you can read a step in the Hands on Experience section, switch to FormDesigner to try it out, and then return back to the tutorial to continue to the next step or to review material.

Please Note!
Sometimes people make the mistake of trying to start the FormDesigner program twice. If you attempt this you will get the following error message:

![Error Message]

Unable To Open ECI DataBase

C:\ECI\ECIDBASE.MDB
Couldn't open file 'C:\ECI\ECIDBASE.MDB'.
Visual Basic Error # 3051

This looks fatal, but all it means is that there are two programs trying to open the same form or database. This means that the FormDesigner program tried to open a database already opened by a previous FormDesigner session. When you click OK, notice that you do not have an arrow pointer but rather the hourglass icon, which means "Please Wait". In this case, however, this means that the program is locked up. Simply move the hourglass icon to the EXIT button at the top left hand corner of the screen and click. This will allow you to exit the program.

![Hands on Experience]

Hands on Experience  (Note: read through these steps first
before proceeding!!!!)

STEP 1. Switch to the Program Manager using the Alt and Tab keys. The screen should look like this:

![ECI Program Manager](image)

STEP 2. Start FormDesigner by double clicking on the ECI icon:

![FormDesigner Icon](image)

STEP 3. The FormDesigner screen will look like this:

![FormDesigner Screen](image)

**Text Objects in ECI**

<table>
<thead>
<tr>
<th>Your Name</th>
<th>Alpha Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Years of Schooling</td>
<td>Numeric Field</td>
</tr>
</tbody>
</table>

Please record any comments below regarding logistical or other conditions which adversely affected performance:

![Text Box](image)

STEP 4. Pressing the Alt and Tab keys will produce the following tutorial window:
STEP 5. Releasing the keys will place you back at this screen.

STEP 6. Pressing the Alt and Tab keys again will produce the following window which represents the FormDesigner software:

STEP 7. Releasing the keys will place you in FormDesigner and you will be back at the screen shown in step 3.

STEP 8. Return back to this tutorial screen by pressing and releasing the Alt and Tab keys.

Learning Points
- You can switch to Program Manager by using the Alt and Tab keys.
- Switching to Program Manager allows you to start the FormDesigner program.
- A message will warn you that you will lose data if you modify the form. Click Yes.
- You can then switch back and forth between FormDesigner and the tutorial by using the Alt and Tab keys.
- You can read a step in the tutorial's Hands on Experience section, try it out in FormPlayer, and return to the tutorial to get clarification or to proceed to the next step.
- You will get an error if you try to open the FormDesigner software twice. Simply exit the program if this happens.

Where do I go from here?
To proceed to the next section where you will learn how to use Help in the
FormDesigner software.

If you need to review how Alt and Tab keys work from the beginning, click on the back button [Back] button located at the top of the screen.

To return to the main topics page, click HERE.
FormDesigner Tutorial

Help
There are several ways that you can get help on the FormDesigner software. These include using Quick Line help, the Help menu, and the Help icon. Broad descriptions are provided here since these help aids are modeled after standard Help windows setups.

Quick Line Help
Quick Line Help at the bottom left hand corner of the screen provides information based on where the mouse pointer is located. If you move the mouse pointer around the screen, notice that the Quick Line display changes. For example, if the pointer is located on a text field then Quick Line display will read which tells you the type of field. Other displays you might see include: Static Text Box, Numeric Field, Label, Alpha Field, Next Page, and Table of Contents.

Help Menu
Help is a menu selection in FormDesigner. Help is designed to assist you when you have questions about the FormDesigner system. When you click on the Help menu, the following commands will appear:

These commands provide you with information on the FormDesigner software.

Context Sensitive Help
This menu option (pressing performs the same function) displays help based on where the cursor is focused on the screen. Focus is an important concept to understand about FormDesigner. When FormDesigner is started a field will be outlined as shown below:
If you click on Context Sensitive Help (or press \( F_1 \)) then help will be displayed on static text boxes because this is the type of field that the cursor is focused on. If you click on a different field, such as alpha or numeric, then context sensitive help will be displayed on that type of field.

About Help

This command provides information on the developers of the FormDesigner software.

Contents Help

The Contents help icon is located at the upper right hand side of the screen. Clicking on this icon will display FormDesigner contents help. You can then search or browse for information that you need. This is useful if you are uncertain of the type of help information that you are looking for.

Hands On Experience

STEP 1. Switch to FormDesigner using Alt and Tab keys.

STEP 2. Note that a text box is outlined, indicating where the cursor is focused:

Press \( F_1 \) or click on Context Sensitive Help in the Help menu. Notice the type
of help information that is displayed. Exit help information by clicking on the File menu and clicking Exit, as shown below:

![ECI Database Designer Example Menu](image)

STEP 3. Click on the Help icon and note the kind of information that is displayed. Exit help.

STEP 4. Move the mouse pointer to the Alpha field located toward the top of the form. Click on it so that it becomes outlined as shown below:

![Alpha Field](image)

Press or click on Context Sensitive Help in the Help menu. Notice the type of help information that is displayed and how it is different from STEP 2. Exit help information.

STEP 5. Return to the tutorial.

![Learning Points](image)

**Learning Points**

- Quick Line Help prompts you based on the location of the mouse pointer.

- The Help Menu provides you with context sensitive help and software and form document information.

- The help icon provides contents help which is useful for searching and browsing.

*Where do I go from here?*
To continue click HERE and learn how to retrieve other forms (databases).

To return to the main topics page, click HERE.
FormDesigner Tutorial

Retrieving a Form (Database)
While we could modify the form that is automatically retrieved when you start the FormDesigner software, (located in the C:\ECI directory), it would be nice to begin with a completely blank form. A blank form is contained on the C:\ECI\DESTUT directory.

One thing to remember about FormDesigner is that this software always looks for a form entitled ECIDBASE.MDB. FormDesigner will not retrieve a form with any other name. However, it is likely that you will need to have several different forms for various purposes. Since all these forms have the same name (ECIDBASE.MDB) you will need to have separate directories for each form to avoid accidentally overwriting one. You can retrieve any of these forms by switching to that directory. To retrieve the blank form you will need for this tutorial, you need to switch to the C:\ECI\DESTUT directory.

To do this, click on the File menu at the top of the screen and you will see the following commands displayed:

In this case we want to open a project. By clicking on Open Project the following screen will appear:

Presently, the ECI form (here referred to as a database) for C:\ECI is highlighted. Notice that there are two subdirectories: one is C:\ECI\DESTUT and the other is C:\ECI\PLA\TUT. The blank form is contained under the DESTUT directory. Double clicking to highlight the DESTUT directory will make the menu look like
The DESTUT subdirectory is now highlighted. The ECI database here is also called ECIDBASE.MDB. The database can be chosen by clicking on the OK button. You will receive the following message and you should click No.

Once you have done this, the screen should look like this:
This is a blank form which consists of one page. This is the form that you will modify in this tutorial. Notice that Quick Line help indicates that this is "Page 1 of 1."

Hands on Experience

STEP 1. Switch to the FormDesigner software. You should see a screen that looks like this:
STEP 2. Next, open a new ECI database (form) which is contained on the C:\ECI\DESTUT directory. Click on the File menu. The following subcommands will appear:

STEP 3. Click on Open Project. The following screen will appear:
STEP 4. The database (form) to retrieve is in the C:\ECI\DESTUT directory. Double clicking on the DESTUT directory will highlight it:

STEP 5. Click OK to retrieve the database (form). The screen will look like this, showing a blank form:

STEP 6. Return to this tutorial screen.
Learning Points

- All ECI forms (databases) are called ECIDBASE.MDB.

- Create different directories for various forms to avoid accidental overwriting.

- New forms (databases) may be retrieved using the Open Project command in the File menu.

Where do I go from here?
To proceed to the next section where you will learn how to modify a form (database), click HERE.

To return to the main topics page, click HERE.
FormDesigner Tutorial

Making a Form
Making an ECI form is easy, but it helps to take a few minutes and give serious thought to the kinds of questions that you need answered. This will assist you in designing your form. The purpose of this tutorial is to introduce you to the flexibility that FormDesigner offers in terms of the type of information that you can collect, and how you might want to structure the fields in the form.

Orientation
The first step is to orient you to the form. The blank form should look like this:

There are no fields on the screen and at present there is just one page. In designing a form, the first important thing is to use some "aids" that will help you structure the appearance of the screen. Clicking on the Edit menu will produce the list of commands shown here:
Page Options allows you to change certain default settings on the form you are working on. Clicking on Page Options will produce the following screen:

All pages in a form need to have a title. Form Title allows you to type in a page name that is displayed at the top. Here is an example:
The Form Title option is a good way to document pages in a form.

The next option, Form Originator, allows you to type in your name as designer of the form. For example:

Form Originator

Your Name Here

Show grid allows you to superimpose a grid over the form. This is helpful in lining up fields in the form. By default the grid is turned off, as shown here:

Show Grid

.10"

Clicking on the check box as shown here will turn the grid on with .1 inches between each line:

Show Grid

.10"

Finally, a page designation is displayed, with a default setting of 1:

Page Number - 01

Upon clicking OK, the page will look like this:
Hands on Experience

STEP 1. Switch to FormDesigner.

STEP 2. Click on the Edit menu and choose Page Options, as shown here:
The following screen will appear:

STEP 3. Click in the box by Form Title and enter the text shown below:

Form Title: Alpha numeric, numeric, and text box fields
STEP 4. Click in the box by Form Originator and type in your name (example shown below):

Form Originator: Your Name Here

STEP 5. Next, check the box to superimpose the grid on your form, as shown below:

Show Grid: Yes

STEP 6. Finally, leave the page number as is:

Page Number: 01

STEP 7. Click the OK button to accept the changes.

STEP 8. The screen should now look as it does below:

[Image of a grid]
STEP 9. Return to this tutorial screen.

Learning Points
- The Page Options command in the Edit menu allows you to give a name to the form, the designer's name, superimpose a grid on the screen, and set a page number.

Where do I go from here?
To learn how to size and place labels, click HERE.

To return to the main topics page, click HERE.
FormDesigner Tutorial
Sizing and Placing fields on a form (database)

Once settings have been established in page options and a grid has been superimposed on the form, the next step is to choose and place fields on the page. At the top of the screen, notice that there are a series of icons which represent different kinds of fields.

The first thing you want to do in designing a form is to give the page a label. Labels are important because they tell the user the type of information that is collected on that page. To select label field, click on A. Whenever a field is selected its appearance will change to inverse video and look like this: □. This way you know the type of field that is selected. Next, move the mouse pointer and use the grid to position the upper left hand corner of the label field. Clicking and holding the left mouse button on the grid will establish that corner of the box. Next, drag the cursor while holding the mouse button down. Notice that a "box" appears which will approximate the size of the label field:

As the mouse is dragged the box enlarges to accommodate the position of the mouse:
This allows you to make the field as big or as small as you want to. The next step is to establish the lower right hand corner of this field. This is a page label, so it will need to be a good size:

Now that the lower right hand corner of the box has been established, let go of the mouse button. The screen will now look like this:

Notice that the field type ("Label") is indicated in the field. The next step is to edit the field. Moving the mouse pointer to the field and holding down the right mouse button will display a menu:

This menu gives you a number of options associated with the field created. For
the most part, default settings should be sufficient for most purposes so there will be no discussions regarding border type or background color. FormDesigner help provides more detailed descriptions. Justification and alignment allow you to change the placement of text in a field and they will be discussed shortly. Caption allows you to place a description in the label box. Clicking on Caption produces the following screen:

```
Object Caption
Please Enter The New Caption Or Press Cancel
```

![Image of Object Caption screen]

This screen allows you to enter a caption which will become part of the label field. Using the DEL key will allow you to delete the word "Label" and then enter your own description, shown below:

```
Object Caption
Please Enter The New Caption Or Press Cancel
```

![Image of Object Caption screen]

Clicking OK will accept the caption you have typed in.
The text is now in the label, but we need to make the text fill the field properly. This is accomplished by changing the font size, justification, and alignment. Clicking the right mouse button will produce the menu. Clicking on Font will produce the following screen:

The font is set on Arial and the point size is set on 10, which is relatively small. We need to change the point size so that the text will "fill" the label more fully. By clicking on the thumb we can scroll through the point sizes that are available. Since the text will need to be big, choosing a size of 20 should work:
The Sample at the lower right hand corner allows you to preview the font to see if it is what you want. Clicking OK will accept the changes and the screen now looks like this:

---

The font size is appropriate with the label box. However, it is not centered or aligned properly. To change this, move the pointer to the box and click the right mouse button. The menu will appear. Click on Justification:

- Caption
- Justification ...
- Left
- Alignment ...
- Right
- BorderType ...
- Center
- Font
- Background Color

A submenu to the right will appear. Notice that left justification is checked. To improve the appearance of the label, clicking Center will help. The label now appears like this:
Alpha, Numeric, and Text Fields

This improves the appearance, but it would be nice to align the text in the middle of the box. In the menu, clicking on Alignment will produce the following submenu:

- Caption
- Justification ...
- Alignment ...
- Top
- BorderType ...
- Bottom
- Font
- Middle
- Background Color

Top is checked, indicating that the text is aligned with the top of the field. Clicking on Middle will improve this appearance:

The label for this page is complete.

Deleting Fields
Making forms often takes a few tries to get it right. You may size a field and then decide that you want to start over. Deleting fields is easy. Make sure the field you want to delete is highlighted then click on the edit menu at the top of the screen and choose Cut Object:
This command will delete the highlighted field.

Hands on Experience

STEP 1. Switch to FormDesigner and click on the Label field so that it appears to be in inverse video:

STEP 2. To make a page label, move the cursor and position it to the approximate position shown below, then press and hold the left mouse button:

STEP 3. Continue holding down the mouse button and drag the mouse. Notice that the label field changes size as you move the mouse:
STEP 4. Make the field large by moving the mouse across the field:

STEP 5. Release the left mouse button to fix the lower right hand corner of the box:

STEP 6. Position the mouse pointer on the label field and hold down the right mouse button. A menu will appear:
STEP 7. Click on Caption. The following screen will appear:

![Object Caption](image)

STEP 8. Press the Del key or use the backspace key to delete the word label. Next, type in the caption shown below and click OK:
STEP 9. The label field will now look like this:

Alpha, Numeric, and Text Fields

STEP 10. To change the font size, click the right mouse button and choose Font from the menu:
STEP 11. Change the font point size to 20

![Font dialog box]

and click OK.

STEP 12. Click the right mouse button again to display the menu. Click with the left mouse button on Justification:

![Justification menu]

STEP 13. Click on Center to change the justification. The label field will now look like this:

![Alpha, Numeric, and Text Fields]

STEP 14. Click the right mouse button to display the menu again. Click with the left mouse button on Alignment:
STEP 15. Click on Middle to change the alignment. The label field will now look like this:

STEP 16. Find some empty space below this label and make another label field of any size. An example is shown below:

STEP 17. Now, delete the label you have created. Click the edit menu and choose Cut Object:
The second label you created will be deleted.

STEP 18. Return to the tutorial.

Learning Points
- The superimposed grid helps you place fields in the form.
- Clicking on a field icon changes it to inverse video.
- Position the mouse pointer to place the upper left hand corner of the field and click with the left mouse button.
- Continuing to hold down the left mouse button and dragging the mouse will allow you to size the field. Letting go of the left mouse button will set the lower right hand corner of the field.
- Clicking the right mouse button on a field will display menu features.
- Fields can be deleted with the Cut Object command in the Edit menu.

Where do I go from here?
To learn more about field labels, click HERE.

To return to the main topics menu, click HERE.
FormDesigner Tutorial

More Labels
The importance of labels is clear: it helps the user know the kind of information that is being asked. This page label tells the user that this page will display alpha, numeric, and text fields. As we continue building this form, you will see why.

The label option can also be used for describing the type of information for alpha and numeric fields. To create another label field, simply move the cursor, click to set the upper left hand corner, and size the field. Click again to set the lower right hand corner of the field:

- Alpha, Numeric, and Text Fields

Once the field has been sized it will look like this:

Alpha, Numeric, and Text Fields

Notice that the second label field has the same appearance as the page label but is smaller. This label will ask the user for their name. The caption for this label will read "Your Name Here":

Alpha, Numeric, and Text Fields

The last label for this page will be located further down the page and will ask for years of schooling:
Alpha, Numeric, and Text Fields

Your Name Here

Years of Schooling

As you can see, the labels inform the user of the type of information that is being asked. However, we still haven't given the user a way to enter data. These are only labels that are defined by the designer of the form. The next step is to supply fields for the user to enter data.

Alpha Fields

Since the first label asks for the person's name filling out the form, we want to

use an alpha field. We can select alpha field by clicking on the icon at the top of the screen. As before, we need to size the field and place it beside the label "Your Name Here":

Your Name Here

When the mouse button is released, it will look like this:

Your Name Here

Alpha Field

Notice that this is an alpha field, meaning that it will accept alphabetical and numerical characters input by the user.

Numeric Fields

For the label "Years of Schooling", we want to make sure that users of the system put numbers when responding. One way to ensure this is to use a numeric field, which accepts only numbers as input. Clicking on the numerical field icon will allow you to place and size a numerical field:

Years of Schooling

Numeric Field

Again, notice that that the field's type is clearly indicated.
Hands on Experience

STEP 1. Switch to FormDesigner.

STEP 2. Place and size a label as shown below:

- Alpha, Numeric, and Text Fields

STEP 3. With the mouse pointer located on this field, press the right mouse button to display the menu. Edit the caption to read "Your Name Here":

Alpha, Numeric, and Text Fields

STEP 4. Place and size another label down below "Your Name Here" and give it the name "Years of Schooling":

Alpha, Numeric, and Text Fields

Your Name Here

Years of Schooling
STEP 5. Click on the alpha icon so that it appears to be in inverse video. Next, place and shape an alpha field beside the label "Your Name Here":

Your Name Here

STEP 6. Next, click on the numerical icon so that it appears in inverse video. Next, place and shape a numeric field beside the label "Years of Schooling":

Years of Schooling

STEP 7. Return to this tutorial page.

Learning Points
- The type of field can be changed using the field icons at the top of the screen.

Where do I go from here?
To learn about textboxes, click HERE.

To return to the main topics page, click HERE.
FormDesigner Tutorial

Textboxes
The best way to describe a textbox is that it is like an alpha field with the exception that it can accept multiple lines of information. There are two kinds of textboxes: designer defined and user defined.

Designer defined textboxes (which you will be creating!) are like labels because they tell the user about the kind of information that needs to be collected. Users of the software will not be able to modify designer defined textboxes. Placing and sizing textboxes is the same as for alpha and numeric fields. To choose textboxes, click on the textbox icon: [ ]. Since these will be instructions to the user of the system, we want to size the textbox correctly:

Your Name Here  Alpha Field
Years of Schooling  Numeric Field

By default, any textbox created in FormDesigner is a user defined textbox. Therefore, it is necessary to change the definition of this textbox so that it will accept input from you, the designer. Moving the mouse pointer onto the textbox and clicking the right mouse button will make a menu appear:

Field Name
Static Text
Scroll Bars
Font
Background Color

A Static Textbox will allow the designer of the system to input instructions for the user. Clicking on Static Text produces a thick vertical flashing bar in the textbox:

At this point the designer can enter instructions:
Please describe the type of work that you do and the level and scope of your responsibilities.

Just as for labels, we still need to create a textbox where users of the form can record their responses. Since textboxes are still selected, all that is needed is to place and size another textbox under the designer defined instructions. Once again, the default is a user defined box, so none of the settings need to be changed.

Finished with Page 1!

Page 1 of the form is finished. Before proceeding it is important to save work completed. This is easily accomplished by clicking on the disk icon at the top of the page. It is suggested that work be saved every five minutes.

Adding a New Page

There is more information that we want to collect with this form so it is necessary to add a page to the form. This is accomplished by clicking on the Edit menu and selecting Add a Page. This will add a blank page to the form.
Hands on Experience

STEP 1. Switch to FormDesigner.

STEP 2. Select the Textbox icon which will change to inverse video, indicating that it is selected.

STEP 3. Place and size the textbox, as shown below:

Your Name Here

Years of Schooling

STEP 4. Place the mouse pointer on this textbox and click the right mouse button to display a menu:
STEP 5. Click on Static Text. Then, click on the textbox again to select it.

STEP 6. Type in the text that you see below. (Note: if nothing happens when you start typing then double check that you selected Static Text).

Please describe the type of work that you do and the level and scope of your responsibilities.

STEP 7. Place and size another textbox, as shown below:

Please describe the type of work that you do and the level and scope of your responsibilities.

STEP 8. Select the second text box by clicking on it and try to type something in. Note what happens.

STEP 9. Save the page by clicking on the disk icon at the top of the screen.

STEP 10. Click on the Edit menu and select Add a Page.
You should see a blank screen which is the new page you have added:

Learning Points

- There are two kinds of textboxes: designer defined and user defined.
• Place and size textboxes just like labels, alpha fields, and numeric fields.

• Save your form using the disk icon: 

• Use the Add a Page command in the Edit menu to add pages to a form.

Where do I go from here?
To move on to Date/Time fields, click HERE.

To return to the main topics menu, click HERE.
FormDesigner Tutorial

Date/Time Fields
Sometimes it is important for the user of the form to indicate date or time information.

Sizing and placing date/time fields works the same way as for alpha or numeric fields. After labels are created, choose the date/time icon.

The label and date/time field would look like this:

Date of Birth  

By default a date/time field is a date field. Another field, however, may need time information:

Time You Ate Lunch  

In this case it is necessary to change the field type. Moving the mouse pointer to the field and clicking the right mouse button will produce a menu. Clicking on Date/Time Format produces a submenu. Notice that Date is checked:

Field Name  
Date/Time Format ...  
Font  
Background Color

Clicking on Time will change the field definition:

Time You Ate Lunch  

HANDS ON EXPERIENCE

STEP 1. Switch to FormDesigner. You should be on page 2, which is blank:
STEP 2. First, choose Page Options in the Edit menu. Under Form Title type in Date/Time Fields. Place your name by Form Originator. The grid should already be checked. Click OK to return to the screen.

STEP 3. Choose Label □ and create a page label like this:

Date/Time Fields

STEP 4. Create several other labels for different time/date information, as shown below:

Your Birth Date

Time You Woke Up

Computer System

Time You Went to Lunch
STEP 5. Choose the date/time icon which will change to inverse video. Place and size the field by each of the labels you have created:

Your Birth Date  
Time You Woke Up  
Computer System  
Time You Went to Lunch

STEP 6. Move the mouse pointer to the two time labels and click with the right mouse button. A menu will appear. Click on Date/Time Format and click on Time:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Date Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time Format</td>
<td>✓ Date</td>
</tr>
<tr>
<td>Font</td>
<td>Time</td>
</tr>
<tr>
<td>Background Color</td>
<td></td>
</tr>
</tbody>
</table>

STEP 7. Change the other field below it to a time field. The screen should now look like this:

Your Birth Date  
Time You Woke Up  
Computer System  
Time You Went to Lunch

STEP 8. Save this page of the form by clicking on the disk icon at the top of the page.

STEP 9. Create another page by clicking on the Add a Page command in the Edit menu.
STEP 10. Return to the tutorial.

Learning Points
- Date/Time fields provide an easy method to record date or time information.

Where do I go from here?
To move on to checkboxes and listboxes, click HERE.

To return to the main topics page click HERE.
FormDesigner Tutorial

Noneditable Fields (Checkboxes and Listboxes)
Noneditable fields get their name because they present predefined choices to the user of the software. Since you are designing the form, you determine the choices for the user.

There are two types of noneditable fields. The first is the checkbox: ☑️. The checkbox presents the user with a yes or no choice. The user simply clicks the checkbox to indicate that the statement is true or leaves it blank to indicate that the statement is not true. In this example, the basic course is checked indicating that it has been completed, but the advanced course has not been completed:

☑️ Basic Course

☐ Advanced Course

Listboxes 📜 present the user with choices defined by the designer of the form. After sizing a listbox, clicking with the right mouse button produces the following menu:

Company

Field Name
Edit List Item ...
Font
Background Color

Clicking on Edit List Item allows the designer to add a series of choices:
Clicking OK will accept the choices. The list box will now look like this:

Company
A
Hands on Experience
STEP 1. Switch to FormDesigner.

STEP 2. You should be on the third page of the form, which is blank.

STEP 3. Click on the Page Options command in the Edit menu and enter the Page Title as Checkboxes and Listboxes.

STEP 4. Place the following label at the top of the page:

```
Checkbox and Listbox Fields
```

STEP 5. Click on checkbox which will appear in inverse video and size it on the screen, as shown below:

```
Check Box
```

STEP 6. Move the mouse pointer to the box and click the right mouse button. A menu will appear:

```
Check Box
Field Name
Caption
Font
```

STEP 7. Click on Caption:
STEP 8. Use the Del key to erase Check Box and type in Basic Course:
STEP 9. Click OK. The checkbox should now look like this:

- Basic Course

STEP 10. Make another checkbox that looks like this:

- Advanced Course

STEP 11. To make a listbox, create a label that looks like this:

Company

STEP 12. Click on the listboxes icon so that it appears in inverse video. Next, place and size the listbox:
STEP 13. Click the right mouse button to display the menu:

- Field Name
- Edit List Item ...
- Font
- Background Color

STEP 14. Click Edit List Item. You will see the following screen:
STEP 15. Click on Add to input an entry. The following screen will appear:

STEP 16. Enter the letter A and click OK. The screen will now look like this:
STEP 17. Click on Add and enter the letters B, C, D, and E. The screen should then look like this:
STEP 18. Notice that the choices are not in alphabetical order. Simply click on the Sort button to alphabetize the list. Click on OK to accept the changes.

STEP 19. The listbox will now look like this:

STEP 20. Save the form by clicking on the disk icon: 

STEP 21. Return to the tutorial.

Learning Points
- Checkboxes and listboxes present the user with predefined choices.

Where do I go from here?
To find out how to view your finished form, click HERE.

To return to the main topics page, click HERE.
FormDesigner Tutorial

Switching to FormPlayer
You are now finished with your form!!!!! Let's say that we want to see the finished product as it would appear to the user. One way to do this is to "switch"

to FormPlayer mode which can be done with the player icon: 🎨. This is a way to preview the form you have created to see what it looks like to the user.

You can switch back to FormDesigner by clicking the tools icon: 🤓. This way you can switch to FormPlayer, see how the form appears, then switch back to FormDesigner to make additional changes.

Hands on Experience
STEP 1. Switch to FormDesigner.

STEP 2. Click the FormPlayer icon 🎨 at the top of the screen. You will enter FormPlayer and it should look like this:

![FormPlayer Interface]

Checkbox and Listbox Fields

Company

Advanced Course

Basic Course
STEP 3. Move to different pages in the form by using the forward and backward arrows. Return to FormDesigner mode by clicking on the Designer icon.

STEP 4. Return to the tutorial.

Learning Points

- You can switch to FormPlayer by using the player icon: and back to FormDesigner by using the designer icon:

- Forward and backward page arrows allow you to move through the form.

Where do I go from here?
To learn how to save and exit your form, click HERE.

To return to the main topics page, click HERE.
FormDesigner Tutorial

Saving Your Form
It's always advisable to save your form when you are done. This is accomplished by clicking on the disk icon:  

Exiting FormDesigner

You can exit FormDesigner by clicking on the exit icon at the top left hand corner of the screen. You may be prompted to save your form and you should click Yes.

Hands on Experience
STEP 1. Switch to FormDesigner.

STEP 2. Save your form by using the disk icon:  

STEP 3. Exit FormDesigner by clicking the exit icon . You will be returned to this page.

Learning Points

- The disk icon saves your form.

- The exit icon exits your form.

Where do I go from here?
To review a summary of the FormDesigner tutorial, click HERE.
To return to the main topics page, click HERE.
FormDesigner Tutorial

What you should know about FormDesigner

1. How do I start and switch to FormDesigner?
2. How do I use Help in the FormDesigner software?
3. How do I set up a page to be designed?
4. How do I place and size labels?
5. How do I place and size alpha and numeric fields?
6. How do I add a page to a form?
7. How do I place and size date/time fields?
8. How do I place and size checkboxes and listboxes?
9. How do I switch to FormPlayer to see how my form will look like to the user?
10. How do I save a form in FormDesigner?
11. How do I exit FormDesigner?
12. I'm not sure where to start. I think I need to look at general topic areas.
FormPlayer Tutorial

Welcome to the FormPlayer Tutorial
This tutorial will give you hands on experience with FormPlayer. With a little practice it's easy to use FormPlayer!!

FormPlayer allows you to enter data into a predefined electronic form. FormPlayer makes it easy to enter ratings and comments such as those made by observers of military exercises.

How the tutorial works
A tutorial isn't something that you just read!!! A good tutorial gives you hands on experience with the software that you are learning. Therefore, you will be switching back and forth between the tutorial and the FormPlayer software. You will learn by doing.

The structure for this tutorial will show you a concept about FormPlayer and describe it using text and pictures. Then, you will switch to FormPlayer so that you can get hands on experience.

IMPORTANT NOTE
Before proceeding, it is important to remember that all the commands for this tutorial will refer to the mouse pointer and key strokes. The tutorial and FormPlayer assume knowledge of basic windows commands. Any references to menu commands or clicking on objects refers to using the mouse pointer:

Whenever the program is processing the hourglass icon will appear: . Pen users wanting to learn how to use pen commands should consult Windows Pen Help because this material will not be covered in this tutorial.

To continue, click HERE.
FormPlayer Tutorial

Background

FormPlayer allows you to enter information into a predefined electronic form. In other words, use FormPlayer when you need to enter data.

There is a companion software program called FormDesigner and its purpose is to create the electronic forms used by FormPlayer.

It is important to understand the distinction between these two software programs. FormPlayer is used to enter data into forms. FormDesigner is used to make forms.

It is recommended that if you do not have experience with either software package to begin with FormPlayer. Click HERE to continue.
FormPlayer Tutorial

Overview of Topics
This page covers the major topics for the FormPlayer tutorial. You can switch directly to these topics by clicking on them. If this is the first time you have done the tutorial, start with topic 1.

Part I. Getting Started
Topic 1. How to switch to FormPlayer using the Alt + Tab keys.

Topic 2. How to use Help.

Part II. How Electronic Forms Work
Topic 3. How to enter information and move to different text fields.

Topic 4. How to move to the next page in a form.

Topic 5. How to enter information into Date/Time fields.

Topic 6. How to enter information into Noneditable fields.

Topic 7. How to move to different records in a database and how to create new records.

Topic 8. How to save your work and exit the FormPlayer program.

Part III. Summing up
Topic 9. Summary of what you should know about FormPlayer.

These nine topics provide you with the basics for understanding and using FormPlayer.
FormPlayer Tutorial

First things first
First, you need to learn how to switch back and forth between the tutorial and FormPlayer. This is important because it will allow you to try out things discussed in the tutorial. You can do this by holding down the Alt key and then pressing the Tab key. A window will appear as shown below displaying the Program Manager icon:

![Program Manager](image)

Pressing the Tab key again while holding down the Alt key will display any other active sessions that you have in the same window format as above. For example, pressing the Tab key again (while holding the Alt key) will display the following window:

![FormPlayer Tutorial](image)

This window is for the FormPlayer tutorial which you are now running. If you release the keys you are holding down you will be placed in the session window that is currently displayed on the screen.

![Hands on Experience](image)

**Hands on Experience (Note: read through these steps first before proceeding!!)!**

**STEP 1.** Hold down the Tab and Alt keys at the same time. You should see the following window displayed:

![Program Manager](image)

**STEP 2.** Release the keys. You should now be in program manager which should look like this:
STEP 3. Hold down the **Alt** and **Tab** key again. The following window should appear:

![FormPlayer Tutorial](image)

STEP 4. Releasing the keys will bring you back to this tutorial screen.

![Book](image)

**Learning Points**
- Use **Alt** + **Tab** keys to display active sessions.
- While holding down the **Alt** key, continue pressing the **Tab** key to display other sessions.
- When you get to the session you want, release both keys.

**Where do I go from here?**
To proceed to the next section where you will learn more about **Alt + Tab**.

To return to the main topics page, click [HERE](#).
FormPlayer Tutorial

Starting FormPlayer
Since it is critical to switch to FormPlayer for this tutorial to be effective, we need to learn how to switch to Program Manager, start FormPlayer, and return back to the tutorial. You have already learned the first part about how to switch. Now, all you need to know is how to start FormPlayer.

When you switch to Program Manager using the Alt and Tab keys the screen should look like this:

![FormPlayer window with ECI, Developer, ECI QUICK-REPORT, PocketText, FormPlayer tutorial, and FormDesigner tutorial icons]

You are now located at the Electronic Collection Instrument (ECI) work group containing icons representing different programs. To start FormPlayer, double click on the ECI icon:

![ECI icon]

You should then see the following screen displayed:

![FormPlayer interface with text objects in ECI]

Text Objects in ECI

Your Name

Years of Schooling

Please record any comments below regarding logistical or other conditions which adversely affected performance.
You have started the FormPlayer software. More importantly, you have two programs running at the same time: the tutorial and FormPlayer. If you hold down the Alt and Tab keys the tutorial window will appear:

FormPlayer Tutorial

Releasing the keys at this point will place you back in the tutorial on this screen. Pressing the Alt and Tab key again will make the following window appear:

ECI

This window represents the FormPlayer software. Releasing the keys will place you in the FormPlayer software. You can now directly switch between the tutorial and FormPlayer using the Alt and Tab keys. This is useful because you can read a step in the Hands on Experience section, switch to FormPlayer to try it out, and then return back to the tutorial to continue to the next step or to review material.

Please Note!
Sometimes people make the mistake of trying to start the FormPlayer program twice. If you attempt this you will get the following error message:

Unable To Open ECI DataBase

C:\EC\ECIDBASE.MDB
Couldn't open file 'C:\EC\ECIDBASE.MDB'.
Visual Basic Error # 3051

This looks fatal, but all it means is that there are two programs trying to open the same database. This means that the FormPlayer program tried to open a database that is already opened by a previous FormPlayer session. When you click OK, notice that you do not have an arrow pointer but rather the hourglass.
icon, which means "Please Wait". In this case, however, this means that
the program is locked up. Simply move the hourglass icon to the EXIT
button at the top left hand corner of the screen and click. This will allow you to
exit the program.

Hands on Experience (Note: read through these steps first
before proceeding!!!!)

STEP 1. Switch to the Program Manager using the Alt and Tab keys. The screen
should look like this:

<table>
<thead>
<tr>
<th></th>
<th>ECI</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECI</td>
<td>Developer</td>
</tr>
<tr>
<td></td>
<td>ECI</td>
</tr>
<tr>
<td></td>
<td>QUICK-REPORT</td>
</tr>
<tr>
<td></td>
<td>PocketText</td>
</tr>
<tr>
<td></td>
<td>FormPlayer</td>
</tr>
<tr>
<td></td>
<td>FormDesigner</td>
</tr>
<tr>
<td></td>
<td>tutorial</td>
</tr>
</tbody>
</table>

STEP 2. Start FormPlayer by double clicking on the ECI icon:

STEP 3. The FormPlayer screen should look like this:
Text Objects in ECI

Your Name

Years of Schooling

Please record any comments below regarding logistical or other conditions which adversely affected performance.

STEP 4. Pressing the Alt and Tab keys will produce the following tutorial window:

FormPlayer Tutorial

STEP 5. Releasing the keys will place you back at this screen.

STEP 6. Pressing the Alt and Tab keys again will produce the following window which represents the FormPlayer software:

ECI

STEP 7. Releasing the keys will place you in FormPlayer and you will be back at the screen shown in step 3.

STEP 8. Return back to this tutorial screen by pressing and releasing the Alt and Tab keys.
Learning Points

- You can switch to Program Manager by using the Alt and Tab keys.

- Switching to Program Manager allows you to start the FormPlayer program.

- You can then switch back and forth between FormPlayer and the tutorial by using the Alt and Tab keys.

- You can read a step in the tutorial's Hands on Experience section, try it out in FormPlayer, and return to the tutorial to get clarification or to proceed to the next step.

- You will get an error if you try to open the FormPlayer software twice. Simply exit the program if this happens.

Where do I go from here?
To proceed to the next section where you will learn how to use the Help menu.

If you need to review how Alt and Tab keys work from the beginning, click on the back button button located at the top of the screen.

To return to the main topics page, click HERE.
FormPlayer Tutorial

Help
There are several ways that you can get help on the FormPlayer software. These include using Quick Line help, the Help menu, and the Help icon. Broad descriptions are provided here since these help aids are modelled after standard Help windows setups.

Quick Line Help
Quick Line Help at the bottom left hand corner of the screen provides information based on where the mouse pointer is located. If you move the mouse pointer around the screen, notice that the Quick Line display changes. For example, if the pointer is located on a text field then Quick Line display will read prompting you that you can enter text information where the mouse pointer is located. Other displays you might see include:

Read Only Text
Enter Form Data
Next Page
Table of Contents
GoTo Next Record
Exit ECI Program

Help Menu
Help is a menu selection in FormPlayer. Help is designed to assist you when you have questions about the FormPlayer system. When you click on the Help menu, the following commands will appear:
These commands provide you with information on the FormPlayer software.

**Context Sensitive Help**

This menu option (pressing \( F1 \) performs the same function) displays help based on where the cursor is focused on the screen. Focus is an important concept to understand about FormPlayer. When FormPlayer is started, the cursor will be located in the first field on the first page of the form. Notice that a flashing vertical bar appears in this field, like so:

Your Name

If you click on Context Sensitive Help (or press \( F1 \)) then help will be displayed on alpha numeric fields because this is the type of field that the cursor is located in. If you click on a time/date field then context sensitive help will be displayed on that type of field.

**Contents Help**

The Contents help icon is located at the upper right hand side of the screen. Clicking on this icon will display FormPlayer contents help. You can then search or browse for information that you need. This is useful if you are uncertain of the type of help information that you are looking for.

**Data Help**

This option displays documentation related to the form you are using. It is a reference source.
About Help

This command provides information on the developers of the FormPlayer software.

Hands On Experience

STEP 1. Switch to FormPlayer using Alt and Tab keys.

STEP 2. Note that the cursor (vertical flashing bar) is located in the first field:

Your Name __________________________. Press F1 or click on Context Sensitive Help in the Help menu. Notice the type of help information that is displayed. Exit help information by clicking on the Done button.

STEP 3. Click on the Help icon (?) and note the kind of information that is displayed. Exit help.

STEP 4. Move the mouse pointer to the text box at the bottom of the screen and click on it so that the vertical bar flashes within the box, as shown below:
Please record any comments below regarding logistical or other conditions which adversely affected performance:

Press F1 or click on Context Sensitive Help in the Help menu. Notice the type of help information that is displayed and how it is different from STEP 2. Exit help information.

STEP 5. Return to the tutorial.

Learning Points
- Quick Line Help prompts you based on the location of the mouse pointer.
- The Help Menu provides you with context sensitive help and software and form document information.
- The help icon provides contents help which is useful for searching and browsing.

Where do I go from here?
To continue click HERE for an introduction to moving around on a page of a form and entering data.

To return to the main topic page, click HERE.
FormPlayer Tutorial

Moving to Different Fields and Entering Data

Now that you know how to start FormPlayer and move back and forth from the tutorial, it is important to understand how to enter data and move around in the form. Data is entered into fields. There are different kinds of fields. Some allow you to enter text, like a word processor. Some give you predefined choices. Some allow you to enter time or date information.

There are seven different kinds of fields in FormPlayer. These fields can be divided into three categories: text, time/date, and non-editable. The FormPlayer form contains three different pages that illustrate each of these categories of fields. This section will focus on text fields.

Moving between Fields
There are two main ways to move between fields.

The first is to use the mouse pointer , move it to the desired field, and click. A thick vertical blinking cursor appearing in the field will indicate that you are ready to enter data.

The second way is to use the Tab key. Usually this key allows you to indent a paragraph in most word processing programs. However, with FormPlayer the tab key moves you to the next field. The Enter key will not move the cursor to other fields, however it will place carriage returns in a text box.

Entering Data in Text Fields
Text fields allow the user to enter a variety of customized information such as short phrases, numbers, and comments. Three fields fall into this category:

1. Alpha-numeric: this field accepts both alphabetical and numerical characters. The field contains one line and a maximum of 64 characters. Here is an example of an alpha-numeric field:

   ![Your Name](Your Name)

   You can enter characters in the white box area. To enter information, simply click in the white box. A blinking cursor will appear:

   ![Your Name](Your Name)

   You can now enter any alphabetical or numerical characters. For example:

   ![Your Name](Smith, Jonathon “Johnny”)

   

2. Numeric: this field accepts numerical characters only. This field, like
alpha-numeric fields, is one line and holds a maximum of 64 characters. Here is an example of a numeric field:

Years of Schooling [ ]

Notice that it looks exactly the same as an alpha-numeric field. The difference is that this field will not accept alphabetical characters. If you try to type in alphabetical characters nothing will happen. When you type in numbers, however, the numeric field will accept them:

Years of Schooling [16]

3. Textbox: this field accepts alphabetical and/or numerical characters. It is similar to the alpha-numeric field with the exception that the user can enter more than one line of text (total of 65K bytes). Here is an example of a text box:

Please record any comments below regarding logistical or other conditions which adversely affected performance:

```

```

The only difference between a textbox and an alpha-numeric field is that a text box has multiple lines where information can be entered.

Notice that the cursor is located within the textbox. The instruction box above it is "read only" meaning that you can not edit or change that field. A sample entry is shown below:

Please record any comments below regarding logistical or other conditions which adversely affected performance:

This is a text box. A text box is similar to an alpha-numeric field with the exception that text boxes are multiple line rather than single line. As you type and get to the end of a line you are automatically placed on the next line. You can not use Tabs to indent paragraphs because a tab will move you to the next field.
Hands on Experience

STEP 1: Switch to FormPlayer

STEP 2: Page 1 of the form contains examples of each type of text field and should look like this:

![Image of FormPlayer window]

Text Objects in ECI

Your Name

Years of Schooling

Please record any comments below regarding logistical or other conditions which adversely affected performance:

[Text box]

The cursor should be positioned on the first field (entitled Your Name), which is alphanumeric. Type your first, middle, and last name into that field.

STEP 3: The next field (entitled Years of Schooling) is a numeric field. Move the mouse pointer and click to position the cursor in this field. Enter the number of years of schooling you have had. Try to enter letters into this field and notice what happens.

STEP 4: The last field on this page is a text box. Position the cursor in this text box. Enter the sentences shown below in the text box.
Please record any comments below regarding logistical or other conditions which adversely affected performance:

This is a text box. A text box is similar to an alpha-numeric field with the exception that text boxes are multiple line rather than single line. As you type and get to the end of a line you are automatically placed on the next line. You can not use Tabs to indent paragraphs because a tab will move you to the next field.

Learning Points

- Text fields let the user enter customized information.
- Three types of text fields are used in FormPlayer: alpha-numeric, numeric, and text box.
- Positioning the mouse pointer and clicking or using the Tab key will move the cursor to different fields.

Where do I go from here?
The next section will teach you how to use Date/Time fields. Click HERE to continue.

To return to the main topics page, click HERE.
FormPlayer Tutorial

Moving to a New Page
As we said earlier, each of the three main categories of fields are contained on three different pages in FormPlayer. Date/Time fields are contained on page 2. The next step is to learn how to move to the next page in the form. In FormPlayer there is a page indicator at the bottom of the page which looks like this:

Page 1 of 3. This tells you that the form contains 3 pages and that you are on page 1. Clicking on the forward arrow moves to the second page of the form and the page indicator will now look like this:

Page 2 of 3. Notice that two arrows now appear, one for moving back to page 1 and another for moving forward to page 3. Clicking on the forward arrow again will move to the next page:

Page 3 of 3. Since there is only a backward arrow on this page this means that you are on the last page of the form.

Table of Contents: when there are many pages in a form, using the forward and backward page arrows becomes cumbersome. You can display a table of contents menu by double clicking in between the page arrows at the bottom of the screen:

![Table of Contents]

This menu provides you with a short description of each page in the form. You can move to any of these pages by clicking to highlight the option and clicking the Go to Page button. In this example page 1 has been selected.

Date/Time Fields
Date/Time fields accept only date or time information. These fields are typically used to enter date or time information regarding when data was recorded.
1. Date: this field accepts dates in the MMDDYY format (for example, October 24, 1994 would be entered as 102494 and January 2, 1983 would be entered as 010283). Note that there are two slashes that appear in this field. The date field automatically enters slashes between month/day/year.

```
Mission Date
/ /
```

You can choose to enter the date yourself or you can press the tab key which will automatically enter the computer system date. If you use the tab key notice that the format changes from this:

```
Mission Date
10/24/94
```

to this:

```
Mission Date
24-Oct-1994
```

after you press the Tab key.

You can also enter the date by moving the mouse pointer to another field and clicking.

2. Time: this field can be used to enter time using standard 24 hour (military time).

The time field automatically places a colon in the time entered.

```
Time Mission
:
```

It is important to precede single hours and minutes with 0s (for example 0101; 0210; etc.). NOTE: THE FIELD WILL NOT ACCEPT THE LETTER "O" IN PLACE OF 0's!!! Once again, you can enter the time yourself or rely on the computer system's internal clock. Pressing tab will move you to the next field. You can also enter the time by moving the mouse pointer to another field and clicking.
Hands on Experience

STEP 1: Switch to FormPlayer

STEP 2: Move to the second page in the form by clicking on the forward page arrow. You should see the screen shown below:

![Form Player Screen]

Time/Date Objects in ECI

<table>
<thead>
<tr>
<th>Mission Date</th>
<th>Time Mission</th>
<th>Time Mission</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year Date of Birth</th>
<th>Time you woke up this morning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

STEP 3: Enter the computer system's date into the Mission Date field using the Tab key.

STEP 4: Enter the following time in the first Time Mission field: 10/24/94.

STEP 5: Enter the computer system's time in the second Time Mission field.
STEP 6: Enter your date of birth in the Your Date of Birth field.

STEP 7. Enter the time you woke up this morning in the last time field.

STEP 8: Return to the tutorial.

---

Learning Points

- Date/Time fields accept only date or time information.

- Pressing the tab key will enter computer system values in either of these fields.

- Positioning the mouse pointer and clicking will move the cursor to another field and enter computer system dates and times.

Where do I go from here?
The next section will teach you how to use Noneditable fields. Click HERE to continue.

To return to the main topics page, click HERE.
FormPlayer Tutorial

Noneditable Fields
Non-editable fields have predefined choices which can not be changed. Fields that fall into this category include check box and list box.

1. Check Boxes: This field stores boolean data (True/False) information. If the checkbox is checked then the statement is true. If the checkbox is not checked, the statement is false.

   ☑ Basic Infantry Course  ☐ Advanced Infantry Course

In the example above the basic infantry course has been taken but the advanced course has not been taken. These are not editable. You can change the response (that is, check or uncheck the box) by clicking on it with the mouse pointer.

2. List Boxes: This field presents you with a predefined list of choices. This type of field is highly useful when there is a standardized list of things to choose from. The choices can not be edited although it may appear that you can. An example list box is shown below:

   Type of Vehicle

   If you click on the downward arrow a list of options will appear:

   Type of Vehicle
   Bradley
   M109 Howitzer
   STINGER
   TOW
   MLRS

   The first option is highlighted. Let’s say, instead that we wanted to highlight TOW. Simply click on TOW so that it becomes highlighted:

   Type of Vehicle
   Bradley
   M109 Howitzer
   STINGER
   TOW
   MLRS

   When you release the mouse button the highlighted selection will appear in the field:
Type of Vehicle

TOW

You can change responses by clicking on the down arrow button and highlighting a different choice.

Hands On Experience

STEP 1. Switch to FormPlayer.

STEP 2. Move to the third (last) page in the form by clicking on the forward page arrow Page 2 of 3 which contains check and list boxes. The screen should appear like it does below:

Non-Editable Objects in ECI

<table>
<thead>
<tr>
<th>Battalion</th>
<th>Brigade</th>
<th>Company</th>
<th>Crew</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Type of Vehicle

- Basic Infantry Course
- Advanced Infantry Course

1. Assault mounted 7-3/4 1013
2. Defend 7-3/4-1021

[Mark Contained]

STEP 3. Check Advanced infantry training. The field should look like this:

☑ Advanced Infantry Course
STEP 4. Uncheck Advanced infantry training. The field should now look like this:

☐ Advanced Infantry Course

STEP 5. Check Basic infantry training. The field should look like this:

☑ Basic Infantry Course

STEP 6. Check MOS Qualified? The field should look like this:

☑ MOS Qualified?

STEP 7. Choose 1st battalion. The field should look like this:

Battalion

1st

STEP 8. Choose 116th brigade. The field should look like this:

Brigade

116th

STEP 9. Choose C company. The field should look like this:

Company

C

STEP 10. Choose crew 21. The field should look like this:

Crew

21

STEP 11. Choose Bradley vehicle. The field should look like this:

Type of Vehicle

Bradley

STEP 12. Return to the tutorial.

Learning Points
• Checkboxes provide an easy way to indicate true/false expressions.
• Listboxes are useful when there is a standardized set of responses to choose from.

• Neither Checkbox or Listbox responses can be edited.

Where do I go from here?
The next step will be to discuss the concept of Records. click HERE to continue.

To return to the main topics page, click HERE.
FormPlayer Tutorial

Records
This part of the tutorial will teach you how to create and move to different records in a database. At this point you are located on page 3 of the form as shown by the page indicator at the bottom of the screen:

Page 3 of 3

It is important to notice that an indicator at the top center of the screen tells you which record you are on:

Record 1 of 1

The information that you have entered on the three pages of this form make up one record in a database. Let us say that you have to record this same information for twenty different people. That would mean that there would be twenty different records in this database. At this point, however, we have just one record. We need to add new records.

Adding New Records
An easy way to add a new record is to click the Next Record button when located on the last record in the database. For example, clicking the forward arrow in the example shown below

Record 1 of 1

will create a new record. FormPlayer assumes, when you click the forward record button on the last record in a database, that you intend to create a new record. You will receive a message that a record is being created. Since the database contained 1 record before you created a new one, the record display at the top of the screen will now look like this:

Record 2 of 2

You are now in a newly created record, which is "Record 2 of 2."

Moving to Different Records
Moving to different records is similar to how you move to different pages. Let's say that we are on record 2 of a 3 record database. The display at the top of the screen will look like this:

Record 2 of 3

Notice that there are two kinds of forward and backward arrows. The arrows without vertical lines, \ and \, allow you to move one record backward or forward. The arrows with vertical lines, \ and \, allow you to move to the
first or last record. These last two commands are very useful when you have many records.

Hands on Experience

STEP 1: Switch to FormPlayer.

STEP 2: The database has one record. Add a new record using the forward arrow button.

STEP 3: Add another record by using the forward arrow button.

STEP 4: Add three more records.

STEP 5: Move to the first record using the button.

STEP 6: Move to the last record using the button.

STEP 7: Move back one record using the button.

STEP 8: Return to the tutorial.

Learning Points
- Each record represents a single observation.
- You can move a single record at a time using the buttons at the top of the screen.
- You can move to the first or last record in the database using the buttons with
the vertical lines.

Where do I go from here?  
To learn how to save and exit a form, click HERE.

To return to the main topics page, click HERE.
FormPlayer Tutorial

Saving a Form
You may be wondering why we haven't discussed how you save a form. The nice thing about FormPlayer is that the form is automatically saved whenever you move to a new page.

Exiting FormPlayer
When you have completed entering information into FormPlayer, exiting the program is easy. Simply click on the exit icon at the top left hand corner of the screen. The form will automatically be saved when you exit.

Hands on Experience
STEP 1. Switch to FormPlayer

STEP 2. Click the Exit icon. You will be placed back at the Program Manager screen:

<table>
<thead>
<tr>
<th>ECI</th>
<th>Developer</th>
<th>ECI</th>
<th>PocketText</th>
<th>FormPlayer tutorial</th>
<th>FormDesigner tutorial</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

STEP 3. Start FormPlayer by clicking on the FormPlayer icon: ECI.

STEP 4. Note that the information you have entered has been saved.

STEP 5. Return to the tutorial.
Learning Points

- FormPlayer automatically saves the form whenever you change a page or exit the FormPlayer program.

Where do I go from here?
This covers the basic introduction to FormPlayer. For a review of the types of things you should know about FormPlayer, click HERE.

To return to the main topics page, click HERE.
Summary: What you should know about FormPlayer
This summary lists a number of questions that will go over the primary things you should have learned about FormPlayer. You can click on the underlined phrase to go directly and review that information. You can return back to this page by clicking on the Back button.

1. How do I start and switch to FormPlayer?
2. How do I use Help in the FormPlayer system?
3. How to move to different pages in a form.
4. What are text fields?
5. What are Date/Time fields?
6. What are Noneditable fields?
7. How do I move to and create records?
8. How do I save my work and exit FormPlayer?
9. I'm not sure where to start. I think I need to look at general topic areas.